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Preface

Intended Audience

Welcome to Release 11i of the Oracle Web Applications Desktop Integrator User
Guide.

This guide assumes you have a working knowledge of the following:
= The principles and customary practices of your business area.
= The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications
product information.

How To Use This Guide

This document contains the information you need to understand and use Oracle
Web Applications Integrator.

s Chapter 1 provides an introduction to and an overview of the Oracle Web
Applications Desktop Integrator.

= Chapter 2 provides information on defining a spreadsheet layout.

»  Chapter 3 provides information on creating a mapping that determines how
data is imported into the spreadsheet.

»  Chapter 4 provides information on creating a spreadsheet.



»  Chapter 5 provides information on creating and uploading General Ledger
journal entries using the Journals Integrator.

= Appendix A provides answers to frequently asked questions about the Oracle
Web Applications Desktop Integrator.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of
assistive technology. This documentation is available in HTML format, and contains
markup to facilitate access by the disabled community. Standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be
accessible to all of our customers. For additional information, visit the Oracle
Accessibility Program Web site at http: //www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation JAWS, a Windows screen
reader, may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, JAWS may not always read a line of text that
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation This
documentation may contain links to Web sites of other companies or organizations
that Oracle Corporation does not own or control. Oracle Corporation neither
evaluates nor makes any representations regarding the accessibility of these Web
sites.

Other Information Sources

You can choose from many sources of information, including online documentation,
training, and support services, to increase your knowledge and understanding of
Oracle Web Applications Integrator.

If this guide refers you to other Oracle Applications documentation, use only the
Release 11i versions of those guides.



Online Documentation

All Oracle Applications documentation is available online (HTML or PDF). Online
help patches are available on MetaLink.

Related Documentation

Oracle Web Applications Integrator shares business and setup information with
other Oracle Applications products. Therefore, you may want to refer to other
product documentation when you set up and use Oracle Web Applications
Integrator.

You can read the documents online by choosing Library from the expandable menu
on your HTML help window, by reading from the Oracle Applications Document
Library CD included in your media pack, or by using a Web browser with a URL
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at
http:/ /oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide

This guide explains how to enter data, query, run reports, and navigate using the
graphical user interface (GUI) available with this release of Oracle Web
Applications Integrator (and any other Oracle Applications products). This guide
also includes information on setting user profiles, as well as running and reviewing
reports and concurrent processes.

You can access this user’s guide online by choosing "Getting Started with Oracle
Applications" from any Oracle Applications help file.

Documents Related to This Product
Oracle General Ledger User’s Guide

This guide provides an introduction to the Oracle General Ledger and outlines how
to create and upload correct journal entries.

xi
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Installation and System Administration

Oracle Web Applications Desktop Integrator Implementation Guide

This guide provides information on implementing and maintaining the Web
Applications Desktop Integrator.

Oracle Applications Concepts

This guide provides an introduction to the concepts, features, technology stack,
architecture, and terminology for Oracle Applications Release 11i. It provides a
useful first book to read before an installation of Oracle Applications. This guide
also introduces the concepts behind Applications-wide features such as Business
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications

This guide provides instructions for managing the installation of Oracle
Applications products. In Release 11i, much of the installation process is handled
using Oracle Rapid Install, which minimizes the time to install Oracle Applications,
the Oracle8 technology stack, and the Oracle8i Server technology stack by
automating many of the required steps. This guide contains instructions for using
Oracle Rapid Install and lists the tasks you need to perform to finish your
installation. You should use this guide in conjunction with individual product
user’s guides and implementation guides.

Upgrading Oracle Applications

Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or
Release 11.0 products to Release 11i. This guide describes the upgrade process and
lists database and product-specific upgrade tasks. You must be either at Release 10.7
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i.
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications

Use this guide to help you run the various AD utilities, such as AutoUpgrade,
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and
others. It contains how-to steps, screenshots, and other information that you need to
run the AD utilities. This guide also provides information on maintaining the
Oracle applications file system and database.



Oracle Applications System Administrator’s Guide

This guide provides planning and reference information for the Oracle Applications
System Administrator. It contains information on how to define security, customize
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide

This guide explains how to define periodic and event alerts to monitor the status of
your Oracle Applications data.

Oracle Applications Developer’s Guide

This guide contains the coding standards followed by the Oracle Applications
development staff. It describes the Oracle Application Object Library components
needed to implement the Oracle Applications user interface described in the Oracle
Applications User Interface Standards for Forms-Based Products. It also provides
information to help you build your custom Oracle Forms Developer 6i forms so that
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle
Applications development staff. It describes the UI for the Oracle Applications
products and how to apply this Ul to the design of an application built by using
Oracle Forms.

Other Implementation Documentation

Multiple Reporting Currencies in Oracle Applications

If you use the Multiple Reporting Currencies feature to record transactions in more
than one currency, use this manual before implementing Oracle Web Applications
Integrator. This manual details additional steps and setup considerations for
implementing Oracle Web Applications Integrator with this feature.

Multiple Organizations in Oracle Applications

This guide describes how to set up and use Oracle Web Applications Integrator
with Oracle Applications' Multiple Organization support feature, so you can define
and support different organization structures when running a single installation of
Oracle Web Applications Integrator.
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Oracle Workflow Administrator's Guide

This guide explains how to complete the setup steps necessary for any Oracle
Applications product that includes workflow-enabled processes, as well as how to
monitor the progress of runtime workflow processes.

Oracle Workflow Developer's Guide

This guide explains how to define new workflow business processes and customize
existing Oracle Applications-embedded workflow processes. It also describes how
to define and customize business events and event subscriptions.

Oracle Workflow User's Guide

This guide describes how Oracle Applications users can view and respond to
workflow notifications and monitor the progress of their workflow processes.

Oracle Workflow APl Reference

This guide describes the APIs provided for developers and administrators to access
Oracle Workflow.

Oracle Applications Flexfields Guide

This guide provides flexfields planning, setup and reference information for the
Oracle Web Applications Integrator implementation team, as well as for users
responsible for the ongoing maintenance of Oracle Applications product data. This
manual also provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals

Each eTechnical Reference Manual (eTRM) contains database diagrams and a
detailed description of database tables, forms, reports, and programs for a specific
Oracle Applications product. This information helps you convert data from your
existing applications, integrate Oracle Applications data with non-Oracle
applications, and write custom reports for Oracle Applications products. Oracle
eTRM is available on Metalink

Oracle Manufacturing APIs and Open Interfaces Manual

This manual contains up-to-date information about integrating with other Oracle
Manufacturing applications and with your other systems. This documentation
includes APIs and open interfaces found in Oracle Manufacturing.



Oracle Order Management Suite APIs and Open Interfaces Manual

This manual contains up-to-date information about integrating with other Oracle
Manufacturing applications and with your other systems. This documentation
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual

This manual describes Oracle Applications messages. This manual is available in
HTML format on the documentation CD-ROM for Release 11i.

Oracle Common Application Components Implementation Guide

Many CRM products use components from CRM Application Foundation. Use this
guide to correctly implement CRM Application Foundation.

Training and Support

Training

Oracle offers training courses to help you and your staff master Oracle Web
Applications Integrator and reach full productivity quickly. You have a choice of
educational environments. You can attend courses offered by Oracle University at
any one of our many Education Centers, you can arrange for our trainers to teach at
your facility, or you can use Oracle Learning Network (OLN), Oracle University's
online education utility. In addition, Oracle training professionals can tailor
standard courses or develop custom courses to meet your needs. For example, you
may want to use your organization’s structure, terminology, and data as examples
in a customized training session delivered at your own facility.

Support

From on-site support to central support, our team of experienced professionals
provides the help and information you need to keep Oracle Web Applications
Integrator working for you. This team includes your Technical Representative,
Account Manager, and Oracle’s large staff of consultants and support specialists
with expertise in your business area, managing an Oracle8i server, and your
hardware and software environment.

OracleMetalLink

OracleMetaLink is your self-service support connection with web, telephone menu,
and e-mail alternatives. Oracle supplies these technologies for your convenience,
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain
information and advice from technical libraries and forums, download patches,

XV



download the latest documentation, look at bug details, and create or update TARs.
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows:
Technical Libraries/ERP Applications/Applications Installation and

Upgrade/ Alerts.

Self-Service Toolkit: You may also find information by navigating to the
Self-Service Toolkit page as follows: Technical Libraries/ERP
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle Applications data
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using
Oracle Applications can update many tables at once. But when you modify Oracle
Applications data using anything other than Oracle Applications, you may change a
row in one table without making corresponding changes in related tables. If your
tables get out of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications
automatically checks that your changes are valid. Oracle Applications also keeps
track of who changes information. If you enter information into database tables
using database tools, you may store invalid information. You also lose the ability to
track who has changed your information because SQL*Plus and other database
tools do not keep a record of changes.

About Oracle

XVi

Oracle Corporation develops and markets an integrated line of software products
for database management, applications development, decision support, and office
automation, as well as Oracle Applications, an integrated suite of more than 160
software modules for financial management, supply chain management,



manufacturing, project systems, human resources and customer relationship
management.

Oracle products are available for mainframes, minicomputers, personal computers,
network computers and personal digital assistants, allowing organizations to
integrate different computers, different operating systems, different networks, and
even different database management systems, into a single, unified computing and
information resource.

Oracle is the world’s leading supplier of software for information management, and
the world’s second largest software company. Oracle offers its database, tools, and
applications products, along with related consulting, education, and support
services, in over 145 countries around the world.

xvii



xviii



1

Introduction to Oracle Web Applications
Desktop Integrator

This chapter discusses the key features and process flows of Oracle Web
Applications Desktop Integrator (Web ADI). Sections in this chapter include:

s Section 1.1, "Overview"

= Section 1.2, "Key Features"

= Section 1.3, "Oracle E-Business Suite Functionality Available on the Desktop"
= Section 1.4, "Accessing Oracle Web Applications Desktop Integrator”

= Section 1.5, "Process Flow for Oracle Web Applications Desktop Integrator"

1.1 Overview

Web ADI brings Oracle E-Business Suite functionality to a spreadsheet, where
familiar data entry and modeling techniques can be used to complete Oracle
E-Business Suite tasks. You can create formatted spreadsheets on your desktop that
allow you to download, view, edit, and create Oracle E-Business Suite data. Data
entry shortcuts (such as copying and pasting or dragging and dropping ranges of
cells) or even using formulas to calculate amounts, can all be used to save time. You
can combine speed and accuracy by invoking lists of values for fields within the
spreadsheet.

Once you are done editing the spreadsheet, you can use Web ADI’s validation
functionality to validate the data before uploading it to the Oracle E-Business Suite.
Validation messages are returned to the spreadsheet, allowing you to identify and
correct invalid data.

Introduction to Oracle Web Applications Desktop Integrator 1-1



Key Features

The fields that appear in the spreadsheet, where they appear, and their default
values can all be customized through Web ADI’s Layout functionality. This allows
you to create a more productive work environment by removing unnecessary fields
from the spreadsheet, and by organizing the spreadsheet in a way that conforms to
your practices.

1.2 Key Features

Oracle Web ADI includes the following features:

Works Via Internet

Web ADI uses Internet computing architecture to lower the total cost of ownership
by having the product centrally installed and maintained. No installation is
required on client machines; you need only Microsoft Internet Explorer and
Microsoft Excel. This architecture also provides superior performance over a WAN
or dialup connection, since the exchange between client and server is simplified
through the use of HTML.

Spreadsheet Interface

Spreadsheets provide a familiar interface that is common in the business
environment. Familiar editing capabilities such as copying and pasting data, and
moving ranges of cells can be used to create or edit large amounts of data.
Recurring data entry is possible by saving a spreadsheet, and then uploading it at
needed intervals, such as every month or every quarter. Spreadsheets offer
additional flexibility in the way work is done; they can be sent to others for
approval or review, and they can be edited when disconnected from a network.

Validates Data

All data in the spreadsheet can be validated against Oracle E-Business Suite
business rules before it is uploaded. This includes validation against key and
descriptive flexfields. Data is validated against accounts, segment security rules,
and cross validation rules. If any errors are found, messages are returned directly to
the spreadsheet, enabling you to correct the errors and successfully upload the data.

Customizations

Use Layout functionality to determine what fields appear in your spreadsheet,
where they appear, and if they contain default values. These definitions can be
saved, reused, and modified as needed.
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Import Data

Have data automatically imported into your Web ADI spreadsheets when they are
created. This information can come from the Oracle E-Business Suite or from a text
file. Imported information can be quickly modified in Excel, validated, and
uploaded to the Oracle E-Business Suite. This feature can be useful when migrating
data from a legacy system to the Oracle E-Business Suite.

1.3 Oracle E-Business Suite Functionality Available on the Desktop

The Oracle E-Business suite task you perform on the desktop is determined by the
Integrator you select in Web ADI. Web ADI is shipped with the General Ledger
Journals integrator. This integrator allows you to create General Ledger journals in
Excel. Other integrators are available as separate patches.

1.4 Accessing Oracle Web Applications Desktop Integrator

You can access Web ADI functionality through a Self Service link on your personal
homepage.

Prerequisites
The following are the prerequisites for Web ADI:

= One of the following operating systems must be installed on the client PC:
= Windows ME
= Windows NT 4.0 with Service Pack 3 or later
= Windows 2000
= Windows XP
= Windows 98
= Internet Explorer 5.0 or greater installed on your machine.

= One of the following versions of Excel:

s 97
= 2000
= 2003
s XP
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Accessing Oracle Web Applications Desktop Integrator

For Web ADI to work with Excel XP, you must:

1. Open Excel

2. Go to Tools > Macro > Security > Trusted Sources

3. Check the "Trust access to Visual Basic Project” option

= Make sure your browser security settings will allow a spreadsheet to be created
on your desktop.

1. Navigate to Tools > Internet Options and choose the Security tab.
2. Select Local Intranet and choose the Custom Level button.
3. Set the following option to Prompt:

Initialize and script Active X controls not marked as safe

Login
Oracle Applications

Responsibility

Desktop Integration

Desktop Integration is the default responsibility to use to access Web ADI. Keep in
mind that responsibilities may have been customized in your operating

environment. See your system administrator for any information on site-specific
customizations.

Navigation

Personal Homepage > Desktop Integration > Create Document
Create Document is the default link to use to create a spreadsheet on your desktop.
Your system administrator may have created a different link for you to use.

Steps
1. Click Desktop Integration.

2. Click Define Layout, Define Mapping, or Create Document. Define a layout
that determines what fields appear in your spreadsheet. Define a mapping to
allow data to be imported into the spreadsheet.
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1.5 Process Flow for Oracle Web Applications Desktop Integrator
Web ADI uses the following process to upload data to the Oracle E-Business Suite:

1.

2
3
4.
5

Define a layout that determines what fields appear in your spreadsheet.
Define a mapping to allow data to be imported into the spreadsheet.
Create the spreadsheet.

Upload the data to the Oracle E-Business Suite.

Monitor the progress of your upload.
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2

Defining a Layout

Sections in this chapter include:

Section 2.1, "Overview of Defining a Layout"
Section 2.2, "Defining a New Layout"
Section 2.3, "Renaming Layouts"

Section 2.4, "Updating Layouts"

Section 2.5, "Duplicating Layouts"

Section 2.6, "Deleting Layouts"

2.1 Overview of Defining a Layout

Layouts allow you to customize the user interface presented in the spreadsheet you
create. Layout functionality can be used to determine the fields in a spreadsheet,
their position, and any default values that automatically populate the fields.

A layout must be defined before you create a spreadsheet in the Create Document
flow. Some integrators offer predefined layouts that can be used, or you can use the
Define Layout flow to create a layout.

You can:

= Define a new layout
= Modify an existing layout

= Duplicate a layout from the list and save it under a different name. You can
then modify this duplicated layout.

= Delete a layout from the list
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Defining a New Layout

2.2 Defining a New Layout

Use this procedure to define or modify a layout.

Login
Oracle Applications

Responsibility
Desktop Integration

Navigation
Personal Homepage > Desktop Integration > Define Layout

Steps

1.

2
3
4.
5

Click Define Layout. The Layout window opens.

Select an Integrator.

Click Go. The Select Layout window opens.

Click Define Layout to define a new layout.

Enter a name and layout key for the new layout.

Layout Name: Name that you will see in the Create Document flow

Layout Key: Key that is used to internally identify the layout, and you cannot
change the layout key once it is specified.

Key names must:
= Contain no spaces
= Consist of uppercase, numeric, or underscore characters

It is recommended that you use the form keyname_your initials to create a
unique key name. For example, NEWBUDGET_AD.

Click Continue. The Define Layout window opens. The Define Layout window
allows you to determine the placement of fields, add optional fields, and set
default values.

Select the values for the fields. Required fields are listed first. All required fields
must be included in your layout. Include optional fields by clicking the Select
checkbox.

2-2 Oracle Web Applications Desktop Integrator User Guide



Defining a New Layout

Field Name: Name of the field.

Placement: Defines the location of the field on the spreadsheet. Choices are
Context, Header, and Line. In your spreadsheet:

Context: Appears at the top of the spreadsheet as read only, contextual
information.

Header: Fields whose values do not change for every record you are
uploading. This region appears above the line region in the
spreadsheet.

Line: Fields whose values change belong in the line region. This is data
you add and modify. For example, Account, Debit, and Credit fields
should be in the line region.

Default Value: Define the default value. For example, for a currency field,
the Default Value might be USD.

Default Type: Specify the type of default:

None: Use when there is no Default Value specified.

Constant: Use when the text entered in the Default Value field will be
used as the default value in the spreadsheet.

Environment: Use to reference an environment variable when setting a
default for a field. Values for the Environment Default Type:

sob.chartofaccountsid: ID of the chart of accounts assigned to your cur-
rent set of books.

sob.periodsetname: Name of the calendar assigned to the current set of
books.

sob.transactioncalendarid: ID of the calendar assigned to the current
set of books.

sob.setofbooksid: ID of the current set of books.
sysdate: System date

database: Name of current database

oauser.id: ID of your current Oracle Applications user.

sob.accountedperiodtype: Value for the Period Type in the current set
of books definition.

sob.currencycode: Currency for current set of books.
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sob.latestencumbranceyear: Last encumbrance year of the current set
of books.

sob.adbflag: Flag will return True or False depending on the current set
of books having average balances enabled.

sob.consolidationflag: Flag will return True or False depending on the
current set of books being a consolidation set of books.

SQL: Use to run a SQL statement to determine the default for the field.
Web ADI will run the SQL statement entered in the Default Value field
and automatically populate the spreadsheet with the result. If more
than one value is returned from the query, the first value is used. You
can use the following tokens in the SQL statement you enter in the
Default Value field:

$profile$.profileName: Enter the name of the profile option, and its
value for the current user’s profile will be returned.

$env$.userid: Returns the current user ID.
$env$.appid: Returns the current application ID.
$env$.respid: Returns the current responsibility ID.
$env$.language: Returns the current session language.

Parameter: Use to reference a parameter that your system administrator
stores in the form function (Self Service Link) you use to access the
Create Document flow.

8. When you have completed your field definitions, click Apply.

2.3 Renaming Layouts

You can rename existing layouts.

Steps

1. Navigate to the Select Layout window and select a layout to update.
2. Click Update. The Update Layout window opens.
3. Enter a new layout name.

4. Click Apply to save the renamed layout.
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2.4 Updating Layouts

You can update existing layouts as required.

Steps

1. Navigate to the Select Layout window and select a layout to update.
2. Click Update. The Update Layout window opens.

3. Click Continue.

4. Edit the layout fields that appear in your spreadsheet.

5. Click Apply to save the modified layout.

2.5 Duplicating Layouts

You can duplicate existing layouts and then edit them as required.

Steps

1. Navigate to the Select Layout window and select a layout to copy.
2. Click Duplicate. The Duplicate Layout window opens.
3. Enter the name and key for the new layout.

4. Click Apply to create the duplicate layout.

2.6 Deleting Layouts

You can delete selected layouts.

Steps

1. Navigate to the Select Layout window and select a layout to delete.
2. Click Delete. The Delete Layout Warning window opens.

3. C(lick OK. You will receive a confirmation of the deletion.
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Defining a Mapping

Sections in this chapter include:

= Section 3.1, "Overview of Defining a Mapping"
= Section 3.2, "Defining Mapping"

= Section 3.3, "Renaming Mappings"

= Section 3.4, "Updating Mappings"

= Section 3.5, "Duplicating Mappings"

= Section 3.6, "Deleting Mappings"

3.1 Overview of Defining a Mapping

You can choose to automatically import data into the spreadsheet during the Create
Document flow, as discussed in Section 4, "Creating a Document". When you choose
to import data on the Content page, you are then prompted to select a mapping.
Web ADI requires a mapping in order to determine where imported data should be
placed in the spreadsheet.

Mapping associates columns in the imported data with columns in the spreadsheet.
You do not need to create new mappings for fields that do not have data, or if a
mapped field is not included in the spreadsheet. Multiple mappings need be created
for Content only if the associations between the downloaded columns and the fields
in the spreadsheet change. If you import text files with varied data structures, you
may have to define more than one mapping for the text file.
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3.2 Defining Mapping

Use this procedure to define mapping between source data and columns in a
spreadsheet.

Login
Oracle Applications

Responsibility
Desktop Integration

Navigation
Personal Homepage > Desktop Integration > Define Mapping

Steps

1.
2.

Click Define Mapping. The Mapping window opens.
Select an Integrator.

Choose the Integrator you will use to import information into a spreadsheet as
part of the Create Document process.

Click Go. The Select Content window opens. Content indicates the information
you will import into your spreadsheet. One or more mappings can be defined
for a particular Content.

Select a Content to import. For example, Text File.

Click Go. The Select Mapping window opens. The Select Mapping window
allows you to create, edit, view, and delete mappings for a Content.

Click Define Mapping. The Define Mapping window opens.

Enter a name for the new mapping, a mapping key, and the number of columns
to be mapped.

Mapping Name: Name that you will use in the Create Document flow

Mapping Key: Key that is used to internally identify the mapping. You cannot
change the mapping key once it is specified.

Key names must:
= Contain no spaces

= Consist of uppercase, numeric, or underscore characters
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10.

11.

It is recommended that you use the form keyname_your initials to create a
unique key name. For example, NEWMAP_SE.

Number of Columns: Enter the number of columns. This can be an estimate.
Columns can be added or deleted later in the Define Mapping process.

Click Next. The Define Mapping - Source to Target Columns window opens.

Associate columns being imported from the Content to fields in the
spreadsheet. Click the list of values for the Source Column to view a list of
available columns to import, and to search for Source Columns. Enter the search
criteria and click Go. Click the radio button next to the column name and then
click select to select columns to map. If you know the name of the Source
Column, you can type it directly into the field without using the list of values.

Use the Target Column field next to each Source Column to create a mapping
between the two fields. Click the list of values for the Target Column to view a
list of available columns to import, and to search for Target Columns. Enter the
search criteria and click Go. Click the radio button next to the column name and
then click select to select columns to map. The Target Column list of values
contains a list of columns that can exist in a spreadsheet. You may add new
rows if more columns need to be mapped.

Some Target Columns support the translation of ID values from Source
Columns into user values to download into a spreadsheet. To find out if the
translation of IDs is supported by a specific column, select that column and
click Lookup. If the column supports the ID translation, a checkbox will appear
under Lookup for that column name. To perform the ID translation, select the
Lookup checkbox for the desired columns.

When you have completed your mapping definition, click Apply.

3.3 Renaming Mappings

You can rename existing mappings.

Steps

1.
2.
3.

Navigate to the Select Mappings window and select a mapping to update.
Click Update. The Update Mapping window opens.
Enter a new mapping name.

Click Apply to save the renamed mapping.
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3.4 Updating Mappings

You can update existing mappings as required.

Steps
1. Navigate to the Select Mapping window and select a mapping to update.

2. Click Update. The Update Mapping window opens.
3. Edit the Mapping fields to associate source columns with target columns.

4. Click Apply to save the mapping under the new name.

3.5 Duplicating Mappings

You can duplicate existing mappings and then edit them as required.

Steps
1. Navigate to the Select Mapping window and select a layout to copy.

2. Click Duplicate. The Duplicate Mapping window opens.
3. Enter the name for the new mapping.

4. Click Apply to save the duplicate mapping.

3.6 Deleting Mappings
You can delete selected mappings.

Steps
1. Navigate to the Select Mappings window and select a mapping to delete.

2. Click Delete. The Delete Mapping Warning window opens.

3. C(lick OK. You will receive a confirmation of the deletion.
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Creating a Document

Sections in this chapter include:

Section 4.1, "Overview of Creating a Spreadsheet”
Section 4.2, "Creating a Spreadsheet”

Section 4.3, "Uploading Data from Spreadsheets"
Section 4.4, "Monitoring Concurrent Requests"
Section 4.5, "Adding Rows to a Spreadsheet"
Section 4.6, "Saving a Spreadsheet to Disk"
Section 4.7, "Opening a Saved Spreadsheet"

Section 4.8, "Downloading Data to a Spreadsheet”

This chapter describes the steps for creating a spreadsheet using the Create
Document page flow. For specific information on the Journals Integrator, see
Section 5, "Creating Journal Entries in Oracle General Ledger".

This chapter describes all of the tasks of creating a spreadsheet. Before you create
your spreadsheet, make sure at least one layout has been defined. Layouts
determine the fields that appear in the spreadsheet you will create. If you intend to
automatically import information into the spreadsheet, make sure that a mapping
has been defined. For details on defining layout, see Section 2, "Defining a Layout";
for details on defining mapping, see Section 3, "Defining a Mapping".

4.1 Overview of Creating a Spreadsheet

The Create Document workflow guides you through steps that allow you to
configure your spreadsheet. As you complete the steps, a guide bar at the top of the
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window lets you know where you are in the process. In addition, the parameters
you select are listed at the top of the window.

Once you have defined the parameters for your spreadsheet, you can review them
before creating the spreadsheet. You can cancel spreadsheet creation at any time
during the process.

The Create Document process you see may vary. Also, some of the parameters in
the Create Document windows might be pre-configured by your system
administrator.

4.2 Creating a Spreadsheet

Use this procedure to create a spreadsheet on your desktop that will allow you to
interact with the Oracle E-Business Suite.

Login
Log into Oracle Applications and navigate to your personal homepage. Under

Navigate, click Desktop Integration. Under Desktop Integration, click Create
Document.

Responsibility
Desktop Integration

Navigation
Personal Homepage > Desktop Integration> Create Document

Steps

1. Click Create Document. The Create Document Shortcuts window opens.
You can reduce the number of steps to create a spreadsheet by saving your
selections to a shortcut that will be shown at the beginning of the Create

Document process. You can create shortcuts by saving the settings you have
selected at the end of this process.

2. Select a shortcut to bypass pages that prompt for the selections saved in the
shortcut.

Select None if you do not want to use a shortcut. You may also delete a shortcut
by selecting it and clicking Delete.
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10.

11.

12.

Click Continue. The Viewer window opens. The viewer is the program that you
will use to view the spreadsheet you are creating.

In the Viewer window, define the following:

= Viewer: Select the Viewer that will be used to open your spreadsheet. For
example, Excel 2000.

= Reporting: Check this box to create a spreadsheet that does not allow
upload. Do not check this box if you will be using an integrator to upload
data later in the process.

Click Next. The Integrator window opens. The selection on this page
determines the integrator you will use.

Select an integrator. The integrator defines the task you will be performing. For
example, to use spreadsheets to create journals to upload into the General
Ledger, select General Ledger - Journals Integrator. See Section 5, "Creating
Journal Entries in Oracle General Ledger" for details on the Journals Integrator.

Click Next. The Layout window opens. Layouts determine which fields are
included in your spreadsheet, their placement, and any default values. See
Section 2, "Defining a Layout" for details on defining custom layouts.

Select the layout to use.

Click Next. The Content window opens. The Content window allows you to
define a blank spreadsheet or automatically populate the spreadsheet with data
when it is created.

Specify the Content to import:

= None: Select to create a blank spreadsheet that contains default values from
the layout definition.

= Text File: Select to automatically import data into the spreadsheet from a
text file.

There may be other content available as well, depending on your environment.

Click Next. When a specific content is selected, the next page in the flow will
prompt you for mapping information and parameters required by the content.
If you selected the Content type Text File, the Mapping window will open.
Otherwise, the Review window will open. See Section 3, "Defining a Mapping"
for details on defining custom mappings.

Specify the filename and the mapping to use in order to map the text file or
other data to the spreadsheet columns. You can choose to import a file from
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your hard drive, or to use a file that has already been imported. All files that
have been imported are saved on the server so they are centrally stored for
reuse.

If you select a Local File:

= You can use the Browse button to open a window to search for the file on
your hard drive.

»  If the file with the same name has already been imported, check the
“Overwrite” box if you want to overwrite the file currently residing on the
server with the one you are importing.

= Indicate the delimiter used in the text file. Enter the delimiter directly into
the text field if “Other” is selected.

= Check “Ignore Consecutive Delimiters” if you do not want to insert a null
value into the spreadsheet when two delimiters exist side by side in the text
file.

= Enter the line in the text file where you want to start importing. The first
few lines in a text file may be header information that you do not want to
import into the spreadsheet.

All of the above parameters are saved against the text file on the server and are
reused when you choose to import the file again.

Note: If you are operating in a multi-byte environment, you must
save the text file with UTF-8 encoding before importing the text file.

13. Click Next. The Review window will open. The Review window displays the
choices you made as you created the spreadsheet.

14. Optionally, click Save. The Select Shortcut window displays. The Select
Shortcut window allows you selected to a shortcut that appears at the
beginning of the Create Document flow. Specify the shortcut name and choose
the settings you want to save. Any settings you save will be pre-specified
whenever you use this shortcut, and the pages displaying those settings will be
skipped. The shortcut name will appear in the list of shortcuts on the Create
Document Shortcuts window. System administrators can save the shortcut to a
form function that can be attached to a user’s menu.

15. Click Apply to save the shortcut and return to the Review Window.
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16. Click Create Document to create your spreadsheet. Excel will open and display

your spreadsheet, containing any data you have imported. After you have
finished modifying the spreadsheet, you can upload the data.

Note: You cannot copy an entire worksheet to a different
workbook. However, you can copy row values from one sheet to
another Web ADI sheet and upload. Copying the entire worksheet
is not supported because, while rows and columns are copied, the
macro code behind the Web ADI worksheet is not copied over to
the new sheet and none of the Web ADI functionality (such as
Upload or List of Values) will work.

Features of Spreadsheets

Structure of the Spreadsheet: The context region appears at the top of the
spreadsheet and contains contextual information that cannot be edited. The
header region is directly below the context. Fields in the header can be edited.
The values entered in the header are common to all the rows in the line region.
The line region appears below the header and is editable. The line region
contains the individual rows that will be uploaded to Oracle Applications.
These regions are determined by layout definitions. See Section 2, "Defining a
Layout" for details.

Upload Flag: When you add or change data, a flag appears in the Upl column
in the line region of the spreadsheet. When you start the upload process, you
can choose to upload all rows or only the flagged rows.

If you copy and paste a line of data, the spreadsheet does not place a flag
character in the Upl column for your new journal line. You can manually enter a
flag by double-clicking in the data cell.

Hint Text: The list region contains a shaded hint area. These hints give you
information about a field, including;:

= Data Type: Text, Date, or Number.

= List of values: "List" indicates that you can retrieve a list of values for the
field by double-clicking on the cell, or by selecting the cell and then
selecting List of Values from the Oracle menu. Some lists of values will
appear as drop down menus.

=  Required Fields: Required fields are indicated with an asterisk (*).
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= View Context: Clicking the View Context button displays or hides the journal
worksheet context information at the top of the worksheet.

= View Header: Clicking the View Header button displays or hides the journal
worksheet header information, located just below the context information.

4.3 Uploading Data from Spreadsheets

After creating and modifying your spreadsheet, you can upload its data to Oracle
Applications.

Steps
To upload data from a spreadsheet to the Oracle Applications:

1.  While viewing your spreadsheet, choose Upload from the Oracle menu. The
Upload Parameters window appears.

2. Select the desired parameters. See Section 4.3.1, "Using Upload Parameters" for
details.

Note: There may not be any upload parameters for you to choose
depending on the integrator you selected and whether or not your
system administrator has prevented the selection of upload
parameters with the BNE Allow Set Parameters profile option.

3. Click Upload to start the upload process. After the upload process completes,
the upload window will indicate whether or not the upload was successful.
Messages will be returned to the spreadsheet that will identify all rows
containing invalid values. If any rows in an upload are found to be invalid,
none of the data in the spreadsheet will be uploaded. You must correct all errors
in order to successfully upload the spreadsheet.

4.3.1 Using Upload Parameters

You may have access to options that control the upload process. Any number of the
following parameters will be available:

= Rows to Upload: Controls which rows in the spreadsheet to upload:

= All Rows: Select to upload all rows in your spreadsheet, regardless of
whether changes have been made.
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= Flagged Rows: Select to upload only those rows that are marked with a flag
character in the Upl column of your spreadsheet. A flag character will
appear against a row that has changed.

= Validate Before Upload: Recommended. Pre-validating will prevent invalid
data from being uploaded to Oracle Applications. Pre-validating is useful when
you expect the import process to be quite lengthy or when you plan to run it
unattended, such as overnight.

4.4 Monitoring Concurrent Requests

The upload process of some integrators start a concurrent program to import the
data you uploaded to an interface table to Oracle Applications. You can monitor
concurrent requests from the spreadsheet.

Steps

1. Select Oracle > Monitor to monitor concurrent requests.

2. Enter a specific Request ID you want to monitor or leave the field blank to
monitor all your requests. Choose Completed, In Progress, or Both from the
menu to further refine the requests to monitor.

Select Refresh and click Monitor to update the status of the request. You can display
a list of requests by selecting each request and clicking Monitor.

You can search for requests by Request ID or owner. Expand the Search criteria
section to search.

4.5 Adding Rows to a Spreadsheet

To add rows to an open spreadsheet:

Steps
1. Unprotect the spreadsheet by selecting Tools > Protection > Unprotect Sheet.

2. Select a row in the lines section of the spreadsheet.
3. Select Insert > Rows.

4. Repeat Insert > Rows selection to add as many rows as you need. The rows you
add will have a flag in the Upl column.

5. Protect the spreadsheet by selecting Tool > Protection > Protect Sheet.
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4.6 Saving a Spreadsheet to Disk

You can save a spreadsheet that you have created to your disk.

Steps

1.
2.

Select File > Save As.

Browse to the desired location for the saved file.

3. Click OK.

4.7 Opening a Saved Spreadsheet

You can open a Web ADI spreadsheet that you have saved to disk.

Steps

1. Open the spreadsheet.

2. Attempt to use any of the options in the Oracle menu (Upload, Monitor,
Download, List of Values, About).

3. You will be prompted to log into Oracle Applications.

4. Select a Responsibility. You must select the same responsibility that was used to
create the spreadsheet you are attempting to open.

5. Modify the spreadsheet as needed.

6. Upload or save the spreadsheet when you are finished.

4.8 Downloading Data to a Spreadsheet

Download enables you to refresh data you have imported into your spreadsheet.
Download is not available if the spreadsheet does not contain imported data.

Steps
Select Oracle > Download to refresh imported data.

Note: Any new rows of data or other modifications you have
made on the spreadsheet will be overwritten when you use
Download to refresh the data. Be sure to use Download only when
you want to start over with the original data.
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Creating Journal Entries in Oracle General

Ledger

Sections in this chapter include:

Section 5.1, "Overview of Creating Journal Entries"
Section 5.2, "Creating Journal Entries"

Section 5.3, "Mappings for Journal Spreadsheets"
Section 5.4, "Functional Actuals Journals"

Section 5.5, "Foreign Actuals Journals"

Section 5.6, "Budget Journals"

Section 5.7, "Encumbrance Journals"

Section 5.8, "Reverse Journals"

Section 5.9, "Value Added Tax (VAT) Journals"

5.1 Overview of Creating Journal Entries

Web ADI provides integration with the Oracle General Ledger to enable creation of
journal entries through the Journals Integrator. The General Ledger - Journals
Integrator allows you to define journal spreadsheets which you can modify and
upload repeatedly.

Web ADI validates data against the accounts, security rules, and reference
information defined in the General Ledger. Once Web ADI has validated the data,
you can automatically upload your journals to the General Ledger.

With the General Ledger Journals Integrator you can:
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Customize spreadsheets by defining layouts.
Define default values for journal worksheet fields.

Use the powerful spreadsheet features of Excel. For example, you can use
formulas to calculate journal amounts.

Save a journal worksheet to a file, which can then be transferred to another PC
for further changes, even while disconnected from your network.

Users can enter recurring journal entries by saving a journal spreadsheet, and
then uploading it whenever appropriate, such as every month.

5.2 Creating Journal Entries

Use this procedure to create a spreadsheet for General Ledger journal entry, using
the Journals Integrator. For General Ledger guidelines and rules, see the Oracle
General Ledger User’s Guide.

Prerequisites

Define a set of books. Journal worksheets support entering effective and
reversal dates for sets of books that have average balance processing enabled.

Open one or more accounting periods for your set of books.
Create a spreadsheet, as described in Section 4, "Creating a Document".

Have your administrator set the following optional profile options in General
Ledger:

= GLDI: Converted Entry Threshold: Web ADI forces converted currency
journals to balance within a set threshold amount before journal upload.

= GLDI: Balance by Accounting Date: Web ADI forces journal amounts to
balance by accounting date before journal upload.

= GLDI: Create Group ID (GLDI_CREATE_GROUP_ID): When enabled,
Web ADI automatically generates a Group ID during journal upload. Use
this profile option to trace journals posted in GL to specific Web ADI users.
You can choose to generate a Group ID based upon the internal User ID, a
combination of the internal User ID and the Julian date, or an automatic
sequence number.

= ADI: Use Function Security (ADI_USE_FUNCTIONAL_SECURITY):
Prevent users from uploading by setting to "Yes" for a user profile. If
enabled, one of the following functions must be in the menu assigned to the
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Login

user's current responsibility to allow upload: Enter Budget Journals, Enter
Journals, Enter Encumbrances, and Import Journals. If the responsibility
does not have access to any of these functions, an error will be received
when the user selects "Upload" from the Oracle menu in Excel.

Web ADI: Allow Set Parameters: When enabled, users will have the ability
to change their upload parameters

Oracle Applications

Responsibility
Desktop Integration

Navigation
Personal Homepage > Desktop Integration > Create Document

Steps

To create journal entries:

1.

Create a spreadsheet as described in Section 4, "Creating a Document". Make
these choices while using the Create Document page flow:

Viewer: Excel
Integrator: General Ledger - Journals

Content: Text File (optional)

Modify the spreadsheet as desired.

Enter an Account for each journal line by entering the account directly or by
choosing from a list of values.

Enter a Debit or Credit amount for each journal line. You can use Excel
formulas to enter your amounts.

Enter information for any optional fields that you specified if you
customized the worksheet layout.
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Upload your journals to General Ledger by choosing Oracle > Upload. See
Section 4.3, "Uploading Data from Spreadsheets" for details.

Note: If you specify a Reversal Period but leave the Reverse
Journal field blank, the journal upload process will fail for that
spreadsheet.

Uploading the journal entries is a two step process, involving uploading the data to
the interface table, and then, importing it to the General Ledger.

Uploading Journals - Upload Parameters
These upload parameters are available when you upload your journal spreadsheet:

Rows to Upload: Controls which rows in the spreadsheet to upload:

Validate Before Upload: Recommended. Select this checkbox to pre-validate
your journal data before you upload. Pre-validating will minimize the
possibility that the journal import process will fail because of a validation error.

Automatically submit journal import: Select this checkbox to start the import
process automatically after the upload completes. If the upload is successful, an
import concurrent request will be submitted. See Section 4.4, "Monitoring
Concurrent Requests” for details.

= Post Errors to Suspense Account: If there are any account errors, the
journal import program will post the errors to a predefined suspense
account. For this functionality to work, suspense posting must be enabled
in General Ledger.

= Create Summary Journals: Select this checkbox to have journal import
summarize all transactions that share the same account, period, and
currency.

»  Descriptive Flexfields: If your spreadsheet contains descriptive flexfields,
decide whether or not the import program will import this information
after Web ADI uploads it to the interface table.

* Do Not Import: Descriptive Flexfield information in your spreadsheet
will not be imported from the interface table to Oracle Applications

*  Import Without Validation: Select to have the import program import
descriptive flexfield values without validating them
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*  Import With Validation: Select to have the import program validate
and import descriptive flexfield values.

5.3 Mappings for Journal Spreadsheets

In the Define Mapping window, some Target Columns support the translation of ID
values from Source Columns into user values to download into a spreadsheet. To
find out if the translation of IDs is supported by a specific column, select that
column and click Lookup. If the column supports the ID translation, a checkbox
will appear under Lookup for that column name. To perform the ID translation,
select the Lookup checkbox for the desired columns.

For the General Ledger - Journals integrator, ID values in Source Columns mapped
to the following Target Columns can be translated, as listed below:

= Balance Type: Select DESCRIPTION from GL_LOOKUPS where
LOOKUP_CODE = ID value

= Encumbrance Type: Select ENCUMBRANCE_TYPE from GL_
ENCUMBRANCE_TYPES where ENCUMBRANCE_TYPE_ID = ID value

= Budget Name: Select BV.BUDGET_NAME from GL_BUDGET_VERSIONS BV,
GL_BUDGETS B where BV.BUDGET_VERSION_ID = ID value

= Journal Type: Select MEANING from GL_LOOKUPS where
LOOKUP_CODE = ID value

s Reverse Journal: Select MEANING from FND_LOOKUPS where
LOOKUP_CODE = ID value

5.4 Functional Actuals Journals

Use the General Ledger Journals integrator to create actual journal entries using the
functional currency for your selected set of books. You must first have a layout
defined with the relevant fields before using it to create your journal spreadsheet.

5.4.1 Layouts

You may use predefined layouts to create Functional Actuals journals or you may
define your own. The following layouts are shipped with the General Ledger
Journals integrator:

= Functional Actuals — Single: Create single actual journal entries using the
functional currency for your selected set of books.
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= Functional Actuals - Multiple: Create multiple actual journal entries using the
functional currency for your selected set of books.

If you define your own layout, you must:

= Have the Balance Type appear in the context region
= Enter Actual for the Default Value for Balance Type
= Set the Default Type for Balance Type to Constant

5.4.2 Creating Journals

Once you have created a spreadsheet using your functional actuals layout, follow
these steps to enter and upload your journal information.

Steps

1. Select and enter values for Category, Source, Currency, Accounting Date.

Note: Journal worksheets support entering effective and reversal
dates for sets of books that have average balance processing
enabled.

2. Enter an Account for each journal line by entering the account directly or by
choosing from a list of values.

3. Enter a Debit or Credit amount for each journal line. You can use Excel formulas
to enter your amounts.

4. Enter information for an optional field that you specified if you customized the
spreadsheet.

5. Upload your spreadsheet to the General Ledger by selecting Oracle > Upload.
See Section 4.3, "Uploading Data from Spreadsheets" for details.

5.5 Foreign Actuals Journals

Use the General Ledger Journals integrator to create actual journal entries using a
foreign currency. A foreign currency is one which is different from the functional
currency for your selected set of books. You must first have a layout defined with
the relevant fields before using it to create your journal spreadsheet.
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5.5.1 Layouts

You may use predefined layouts to create Foreign Actuals journals or you may
define your own. The following layouts are shipped with the General Ledger
Journals integrator:

= Foreign Actuals - Single: Create single actual journal entries using a foreign
currency.

»  Foreign Actuals - Multiple: Create Multiple actual journal entries using a
foreign currency.

If you define your own layout, you must:

= Have the Balance Type appear in the context region
= Enter Actual for the Default Value for Balance Type
= Set the Default Type for Balance Type to Constant

= Add Conversion Type, Conversion Rate, and Conversion Date to the layout.
Conversion Rate and Conversion Date must both be either in the lines or header
region.

5.5.2 Creating Journals

Once you have created a spreadsheet using your foreign actuals layout, follow these
steps to enter and upload your journal information.

Steps
1. Select and enter values for the Category, Source, Currency, Accounting Date,
and Conversion Type.

2. Enter the Conversion Date and/or Conversion Rate, as required:

= If you selected conversion type User, you must enter a Conversion Rate.
You do not enter a Conversion Date.

= If you selected a conversion type other than User, you must enter a
Conversion Date. You do not enter a Conversion Rate. General Ledger
provides the rate when you import your journals.

3. Enter an Account for each journal line.
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Enter a Debit or Credit amount for each journal line.

Note: General Ledger automatically calculates the converted
value for foreign currency amounts. You can override this by
selecting the Converted Debit and Converted Credit optional fields
in the Update Layout window. General Ledger will use the
converted value you enter.

Enter information for any optional fields in the journal worksheet.

Upload your spreadsheet to the General Ledger by selecting Oracle > Upload.
See Section 4.3, "Uploading Data from Spreadsheets" for details.

5.6 Budget Journals

Use the General Ledger Journals integrator to create journal entries that are posted
against a budget. You must first have a layout defined with the relevant fields
before using it to create your journal spreadsheet.

5.6.1 Layouts

You may use predefined layouts to create Budget journals or you may define your
own. The following layouts are shipped with the General Ledger Journals
integrator:

Budgets - Single: Create single journal entries that are to be posted against a
budget.

Budgets - Multiple: Create multiple journal entries that are to be posted against
a budget.

If you define your own layout, you must:

Have the Balance Type appear in the context region
Enter Budget for the Default Value for Balance Type
Set the Default Type for Balance Type to Constant

Add Organization, Budget Name, and Period to the layout. The Organization
field must be added to the header region.
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5.6.2 Creating Journals

Once you have created a spreadsheet using your budget layout, follow these steps
to enter and upload your journal information.

Steps

1. Select and enter values for Category, Source, Currency, Organization, Budget
Name, and Period.

Note: Accounting Date is not required for Budget journals.

2. Enter an Account for each journal line by entering the account directly or by
choosing from a list of values.

3. Enter a Debit or Credit amount for each journal line. You can use Excel formulas
to enter your amounts.

4. Enter information for an optional field that you specified if you customized the
spreadsheet.

5. Upload your spreadsheet to the General Ledger by selecting Oracle > Upload.
See Section 4.3, "Uploading Data from Spreadsheets" for details.

Note: Budget journals do not need to balance.

5.7 Encumbrance Journals

Use the General Ledger Journals integrator to create journal entries to update
encumbrance balances. You must first have a layout defined with the relevant fields
before using it to create your journal spreadsheet.

5.7.1 Layouts

You may use predefined layouts to create encumbrance journals or you may define
your own. The following layouts are shipped with the General Ledger Journals
integrator:

= Encumbrances - Single: Create single journal entries to update encumbrance
balances.

= Encumbrances - Multiple: Create multiple journal entries to update
encumbrance balances.
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If you define your own layout, you must:

Have the Balance Type appear in the context region

Enter Encumbrance for the Default Value for Balance Type
Set the Default Type for Balance Type to Constant

Add Encumbrance Type to the layout

5.7.2 Creating Journals

Once you have created a spreadsheet using your encumbrance layout, follow these
steps to enter and upload your journal information.

Steps

1.

Select and enter values for Accounting Date, Currency, Category, Source, and
Encumbrance Type.

Enter an Account for each journal line by entering the account directly or by
choosing from a list of values.

Enter a Debit or Credit amount for each journal line. You can use Excel formulas
to enter your amounts.

Enter information for an optional field that you specified if you customized the
spreadsheet.

Upload your spreadsheet to the General Ledger by selecting Oracle > Upload.
See Section 4.3, "Uploading Data from Spreadsheets” for details.

Note: Encumbrances journals do not need to balance.

5.8 Reverse Journals

You can create reverse journals for encumbrance, foreign actuals and functional
actuals journals. Add the following fields to your layout if you want to create a
reverse journal:

Reverse Journal

Reversal Period
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5.9 Value Added Tax (VAT) Journals

You can include VAT information with functional and function actuals journals.
Add all of the following fields to your layout if you want to include VAT
information:

= VAT Context

» Invoice Date

s Tax Code

» Invoice Identifier

s Invoice Amount
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Frequently Asked Questions

This appendix lists frequently asked questions related to the Oracle Web
Applications Desktop Integrator (Web ADI).

Are there plans to develop Web ADI Integrators for Budgets and Oracle
Assets?

Offering Budget and Asset integration are top priorities and will be among the first
solutions after the initial General Ledger - Journals Integrator release.

Is the ADI client server version still supported?
The latest release of the client server version will be supported.

Do any Web ADI components need to be installed on the desktop?
No, you will need Microsoft Internet Explorer and Microsoft Excel.

What versions of Excel can be used with Web ADI?
At this time, Excel 97, 2000, 2003, and XP are supported.

What internet browser does Web ADI require?
Internet Explorer 5 or later is required.

How will new integrators be added?
Integrators will be added to an instance by applying additional patches.
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Why must | set my Intranet browser security setting "Initialize and script
ActiveX controls not marked as safe" to "Prompt"?

Web ADI requires Internet Explorer to make a connection to Excel so that the
spreadsheets can be created. No ActiveX control is actually downloaded or run. It is
the security setting that has special name. When our HTML document attempts to
make the connection to Excel, Internet Explorer looks at its security settings to
determine if this should be allowed. In a default installation, this particular security
setting is set to Disabled.

This means that Web ADI's request is denied, and the spreadsheet cannot be
created. We do not want ANY user to set the value to Enabled, because we cannot
assume that all such requests are valid. The appropriate middle ground is the
Prompt setting, which causes a dialog box to appear when we attempt to invoke
Excel from Internet Explorer. If an end user is concerned about security, then they
can choose No - don't proceed on the dialog, and no spreadsheet will be created. If
the user wishes to create the spreadsheet, then the user allows this one request to go
through. Note that the user had just clicked the Create Document button within the
Web ADI user interface before this dialog appears, and as such they know that they
just asked for a spreadsheet to be created, and for security reasons they are now
being asked for confirmation by Internet Explorer to allow this to happen. So in
conclusion, Web ADI does not require you to download any ActiveX controls, it is
asking for permission to invoke Excel from Internet Explorer.

Does Web ADI work with Single Sigh-On?

Yes, but there are some additional configuration steps. See the Oracle Web
Applications Desktop Integrator Implementation Guide for more information.

Why can't | get past the login page after pressing a Web ADI form
function on the PHP?

The GUEST user name defined in the .dbc file cannot be the same as your Oracle
Applications user name. When you select a Web ADI form function, a guest login to
the database is performed based on the .dbc setting. The Web ADI application is
required to login to the database before it can attempt to take any action, such as
validate your login name and password, or get the profile option to see that Single
Sign On (SSO) server support is enabled. Reference information regarding the Guest
user account can be found in the Oracle Applications System Administrators Guide.

Can | copy a spreadsheet to a PC running a different language?

Spreadsheets can be copied between operating systems running languages under
the following conditions:
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= A spreadsheet generated on any language Windows 98, NT, 2000, ME, or XP
can be copied and used on a Windows NT, 2000, or XP machine running any
language.

= A spreadsheet that is copied onto a Windows 98 or ME machine must be
generated on an operating system running the same language.

Are reference fields supported when entering Key and descriptive
flexfield information into the spreadsheet?
Although reference fields are not currently supported, there are plans to support

this Oracle Applications Flexfield feature. See enhancement 2809958 for the current
status of this feature.

Will Request Center functionality, such as report publishing and drill
down be included in Web ADI?

Request Center functionality migrated to the web will become a part of Report
Manager. Web ADI is not designed to be a reporting tool. Web ADI focuses on
enabling you to download and upload information from a document residing on
the desktop (spreadsheets, word processing, project planning).

Request Center is currently being migrated to the Web in a separate product (Report
Manager). It will not be a one to one mapping of every feature. We are doing the
migration in light of other reporting projects such as DBI, RXi, and Reports 9i,
which means that we will only migrate the Request Center functionality that is
unique to Request Center (for example. FSG publishing, theme management, and
attribute set management). We are currently designing web based submission and
publishing for FSGs. The majority of Request Center users are asking for FSG
submission and publishing on the web, so that is our focus. Once we have migrated
client/server ADI functionality to the web, we will have two products:

= Web ADI for desktop integration

= Report Manager for report publishing, distribution, and presentation

My spreadsheet is only created with 10 rows for entering data. How can |
increase the number of lines so | can enter more than 10 records?

To increase the number of rows you must:
1. Unprotect the sheet by selecting Tools > Protection > Unprotect Sheet.
2. Select a row in the lines section.

3. Select Insert > Rows.
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Can | copy my entire Web ADI worksheet to a different workbook?

You cannot copy an entire worksheet to a different workbook. However, you can
copy row values from one sheet to another Web ADI sheet and upload. Copying the
entire worksheet is not supported because Excel copies only the rows and columns.
The macro code behind the Web ADI worksheet is not copied over to the new sheet,
therefore none of the Web ADI functionality such as Upload or List of Values will
work.
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